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PDF	can	display	documents	in	original	layout	independent	of	the	software	or	screen	you	are	using	to	view	the	file.	Together	with	other	benefits,	PDF	has	been	considered	as	a	popular	and	standard	file	format	in	all	walks	of	life.	However,	a	PDF	file,	especially	a	scanned	PDF,	cannot	be	easily	edited.	Wonder	how	to	make	your	PDF	editable	on	Mac?
From	fully-fledged	PDF	editor,	Preview,	LibreOffice,	to	online	free	tools,	we	collect	5	methods	to	edit	PDFs	on	Mac,	also	will	walk	you	through	the	steps	with	images.	Method	1:	Make	a	PDF	Editable	on	Mac	with	Offline	PDF	Editor	You	may	dislike	PDF	editing	because	of	the	impression	that	it	is	either	complicated	or	expensive,	forget	about	those	old
days.	We	have	more	PDF	editors	today	that	provide	time-efficient	and	professional	way	of	editing	PDF.	Cisdem	PDFMaster	is	highly	recommended,	it	offers	a	comprehensive	suite	of	editing	tools,	excellent	user	experience	and	useful	features.	The	reason	why	Cisdem	PDFMaster	stands	out	from	so	many	PDF	editors	lies	in	its	broad	range	of	features
and	affordable	price,	it	even	offer	a	7	day	free	trial	for	new	users	to	test	its	premium	functions.	Main	features	of	Cisdem	PDFMaster	Edit	PDFs:	add/delete/edit	texts	or	images	Add	comment,	stamp,	signature,	watermark	to	PDF	Compare,	compress,	crop,	protect,	redact	PDFs	Create	PDF	forms	with	fillable	fields	Organize	pages	Convert	PDF	to	10+
formats	View,	bookmark	and	print	PDFs	To	make	a	PDF	editable	on	Mac,	Cisdem	has	three	options:	Edit	a	native	PDF	directly	Make	scanned	PDF	editable	with	OCR	tool	Convert	PDF	to	editable	formats	without	losing	formatting	Directly	Edit	Text	or	Images	in	PDF	without	Changing	Format	Download	and	install	PDFMaster	on	your	Mac.	Free
Download	macOS	11	or	later	Earlier	than	macOS	11,	click	here	Click	Open	Fileto	import	the	PDF	file.	Then	go	to	Edit	PDF,	select	the	texts	you	want	to	edit,	you	can	also	adjust	the	paragraph	formatting,	like	font,	size,	alignment,	text	style	or	add	link.	After	edit,	click	on	Save	to	save	the	editing.	Make	Scanned	PDF	Editable	on	Mac	Open	the	scanned
PDF	in	Cisdem	PDFMaster.	Click	OCR	in	the	tool	bar.	Choose	OCR	pages,	OCR	Plan(Cisdem	PDFMaster	comes	with	2	OCR	plan	-	Online	or	Offline,	while	the	online	plan	support	more	OCR	languages	than	the	offline	plan	)	Click	OCR	to	digitize	text	from	scanned	PDF	or	image	files.	Now	the	scanned	PDF	becomes	editable,	click	on	save	as	txt	or	save
as	PDF	to	store	the	editable	file.	Make	PDF	in	Editable	Format	on	Mac	Free	download	and	launch	Cisdem	PDFMaster	on	your	Mac.	Open	PDF	in	Cisdem	PDFMaster,	clickConverter	in	the	tool	bar.	Choose	the	format	you	need,	here	we	choose	to	convert	to	editable	Word.	In	the	pop	up	windows,	set	the	layout	setting	and	the	page	or	page	range	you
need	to	convert	and	click	Convert	to	start	converting	PDF	files	to	editable	word.	(Optional)	To	batch	convert	PDF	toeditable	format,	you	can	go	back	to	the	main	interface	and	click	batch	in	the	main	interface.	Then	you	can	add	batches	of	PDF	files,	set	the	page	or	page	ranges	you	need	to	convert,	and	start	to	convert	PDF	to	editable	formats	in
batches.	Method	2:	Make	PDF	Editable	on	Mac	with	Preview	Preview	is	the	default	app	that	open	a	PDF	file	on	Mac.Besides	viewing	PDF	files,	italso	comes	with	a	full	set	of	tools	that	can	help	one	easily	edit	PDF	or	image	files,	though	it	dont	support	edit	existing	text	or	images	in	a	PDF	file.	You	can	utilize	Preview	to	view,	add	annotation,	markups,
print,	rotate,	resize,	rename,	highlight,	bookmark,	share,	export	and	edit	PDFs.	With	the	Markup	toolbar,	you	can	add	sketch,	shape,	text,	signature,	note	to	a	PDF.	If,	However,	you	want	to	edit	the	existing	PDF	text,	you	can	also	use	the	white	out	function	to	white	out	and	hide	the	text	then	use	text	tools	to	add	new	texts	to	the	white	out	place.	In
addition,	Preview	don't	support	convert	PDF	files	to	other	formats	to	make	it	editable.	Make	PDF	Editable	on	Mac	Free	with	Preview---	Add	New	Texts	Open	PDF	with	Preview	App.	Click	on	following	Markup	toolbar.	Click	on	T	icon	to	add	a	new	text	filed	to	a	blank	area	of	your	PDF.	Click	on	A	icon	to	change	font	style	or	size,	input	your	texts.	Make
PDF	Editable	on	Mac	Free	with	Preview	---Replace	Texts	Open	PDF	with	Preview	App.	Click	on	Markup	tool,	then	choose	White	color	for	both	border	color	and	fill	color.	Draw	a	white	rectangle	shape	to	white	out	the	texts	you	want	to	replace	with	new	texts.	Then	click	on	T	to	add	a	new	text	filed	to	the	white	out	area	and	click	A	to	change	font
settings.	Now	your	PDF	becomes	editable	on	Mac,	you	can	edit	the	text	or	add	other	contents.	Method	3:	Make	PDF	Editable	on	Mac	with	LibreOffice	LibreOffice	is	totally	free	to	use	and	it	allow	Mac	users	to	open	and	view	PDF	files,	when	you	add	PDF	files	to	the	program,	LibreOffice	will	instantly	make	the	PDF	editable,	you	can	easily	update	text	or
images.	LibreOffice	does	a	great	job	handing	simple	PDF	files,	you	just	need	to	click	open	file	to	navigate	and	add	the	PDF	file.	Note	that	if	your	PDF	is	large	it	will	take	some	time	to	loadingthe	file.	After	loading	the	PDF	file,	just	choose	the	text	you	need	to	edit	and	double	click	on	it	to	change	the	text.	In	the	right	side	of	the	interface,	you	can	change
properties	like	text	style	of	text	color,	and	you	can	add	annotations	like	highlight,	underline,	cross-out,	etc.	LibreOffice	is	free	and	lightweight,	it	is	few	options	that	enable	user	to	edit	text	directly	in	PDF	file,	and	its	free.	Though	for	some	complex	PDF	files	when	opening	with	LibreOffice	it	will	find	that	the	format	and	layout	are	messed	up.	If	you
found	LibreOffice	only	load	the	first	page	of	your	PDF	file	you	can	use	the	page	pane	to	navigate	between	pages.	Click	View	>	Page	pane.	Method	4:	Make	PDF	Editable	on	Mac	with	Google	Drive	If	you	dont	work	on	PDF	very	often,	neither	you	are	working	on	highly	private	PDF	files,	you	can	try	to	make	PDF	editable	online	for	free.	Assuming	you
have	a	Google	Account,	you	can	make	PDF	editable	with	Google	Drive,	the	platform	Google	helps	to	manage	files	online.	Compared	with	other	online	PDF	editors,	it	have	no	limit	on	file	size	and	numbers.	Also,it	is	safe	to	use.	Log	into	your	Google	Account	>	Google	Drive.	Click	"New"	>File	Upload,	import	the	PDF	file	that	you	want	to	make	in	editable
format.	Once	uploaded,	right	click	to	"Open	with	Google	Docs",	if	your	PDFs	are	scanned	copies,	an	OCR	processing	will	start	automatically.	Your	PDF	will	be	opened	in	Google	Docs	and	it	becomes	editable.	After	the	editing,	choose	"File"	>	"Download	as"	to	choose	the	editable	output	format	you	want	to	save	your	PDF	as.	Notes:	The	file	quality
(image	resolution,	format,	layout,	etc)	may	lost	a	little,	remember	to	check	and	manually	adjust	for	accurate	editable	file.	Method	5:	Make	PDF	Editable	withAdobe	Acrobat	If	you	have	installed	Adobe,	I	mean	the	Adobe	Acrobat,	not	Adobe	Reader,	you	can	make	PDF	editable	on	Mac	within	this	program.	It	can	edit	PDF	texts	easily	and	efficiently.	No
matter	your	PDF	is	native	or	scanned,	once	you	import	it	to	Adobe,	it	becomes	editable	and	every	single	word	in	your	PDF	can	be	edited,	modified,	added	or	deleted,	though	these	powerful	features	come	with	a	high	price	tag.	Here	we	take	Adobe	Acrobat	DC	to	demonstrate	how	to	make	PDF	editable	on	Mac.	Open	PDF	with	Adobe	Acrobat	DC.	Go	to
Tools	>	Edit	PDF,	now	you	can	edit	PDF	files	on	Mac.	(Optional)	For	scanned	PDFs,	you	can	go	to	Tools	>	Enhance	Scans	>	Recognize	Text	>	in	This	File	to	make	a	image	PDF	editable	on	Mac.	After	editing,	save	the	file.	Done!	Of	course,	you	can	go	to	"File"and	export	PDF	as	other	editable	format	if	you	want	to.	Basic	Knowledge	of	Edit	PDF	on	Mac
PDF	files	aredifferent	from	document	files	output	by	document	creation/editing	software	like	Word,	Excel,	PPT,	Pages,	Keynote,	etc.	You	are	usually	unable	to	edit	PDF	files.	As	PDF	files	are	made	to	ensure	given	the	same	layout	and	viewing/printing	of	electronic	documents	regardless	of	platform	or	environment.	If	you	need	to	edit	PDF	files,	you	need
to	get	help	from	PDF	editing	software	or	change	PDF	to	a	editable	format	like	word,	excel,	pages,	ppt,	etc.	PDF	editing	software	is	used	to	editing	text	and	images	in	PDF	files,	most	of	the	apps	also	helps	adding	annotations,	converting	and	merging	PDF	files.	Simple	PDF	editings,	such	as	converting	and	creating	PDF	files,adding	annotations,	can	be
done	using	software	such	as	Word	or	preview,	or	free	online	tools.	However,	it	does	not	support	operations	such	as	adding	comments	or	editing	text	and	images	directly	in	PDF	files.	To	make	PDF	editable	on	Mac,	we	recommend	using	PDF	editor	software,	as	with	these	tools	you	can	easily	rewriting	some	fields	of	PDF	files,	contracts	etc.	Also,	If	you
have	PDFscreated	by	scanning	paper	documents	and	you	use	online	PDF	converters	to	convert	it,	the	PDF	will	become	whole	image	that	is	not	editable	and	copyable.	In	this	case,	you	have	no	option	but	use	a	PDF	editor	that	comes	with	OCR	function.	Conclusion	Above-mentioned	5	ways	to	make	PDF	editable	on	Mac	are	all	feasible,	which	solution	do
you	take	depends	on	how	much	you	care	about	the	cost	and	editing	performance.	If	you	have	already	installed	Adobe,	Adobe	absolutely	is	a	good	choice,	but	if	not,	Cisdem	PDFMaster	will	be	the	best	option,	it	offers	3	workarounds	to	make	all	kinds	of	PDFs	editable	on	your	Mac,	and	comes	with	a	lot	of	useful	tools	to	make	your	PDFs	look	great.	Free
Download	macOS	11	or	later	Free	Download	Windows	11/10/8/7	Earlier	than	macOS	11,	click	here	I	am	a	student.	I	created	one	dissertation	and	saved	it	in	PDF	format	with	a	password.	However,	I	lost	the	password	to	open	it.	To	get	rid	of	the	protection	I	tried	many	free	solutions	found	online,	but	failed.	Then	I	downloaded	Passper	for	PDF	to	test	it.
I	have	to	say	that	it	is	really	easy	to	use.	I	paid	for	the	Passper	for	PDF	1-year	plan	and	it	never	disappointed	me.	If	you	are	a	student	like	me,	I	recommend	it!	By	Jason	M.	Contreras	How	can	financial	brands	set	themselves	apart	through	visual	storytelling?	Our	experts	explainhow.Learn	MoreThe	Motorsport	Images	Collections	captures	events	from
1895	to	todays	most	recentcoverage.Discover	The	CollectionCurated,	compelling,	and	worth	your	time.	Explore	our	latest	gallery	of	EditorsPicks.Browse	Editors'	FavoritesHow	can	financial	brands	set	themselves	apart	through	visual	storytelling?	Our	experts	explainhow.Learn	MoreThe	Motorsport	Images	Collections	captures	events	from	1895	to
todays	most	recentcoverage.Discover	The	CollectionCurated,	compelling,	and	worth	your	time.	Explore	our	latest	gallery	of	EditorsPicks.Browse	Editors'	FavoritesHow	can	financial	brands	set	themselves	apart	through	visual	storytelling?	Our	experts	explainhow.Learn	MoreThe	Motorsport	Images	Collections	captures	events	from	1895	to	todays	most
recentcoverage.Discover	The	CollectionCurated,	compelling,	and	worth	your	time.	Explore	our	latest	gallery	of	EditorsPicks.Browse	Editors'	Favorites	PDF	can	display	documents	in	original	layout	independent	of	the	software	or	screen	you	are	using	to	view	the	file.	Together	with	other	benefits,	PDF	has	been	considered	as	a	popular	and	standard	file
format	in	all	walks	of	life.	However,	a	PDF	file,	especially	a	scanned	PDF,	cannot	be	easily	edited.	Wonder	how	to	make	your	PDF	editable	on	Mac?	From	fully-fledged	PDF	editor,	Preview,	LibreOffice,	to	online	free	tools,	we	collect	5	methods	to	edit	PDFs	on	Mac,	also	will	walk	you	through	the	steps	with	images.	Method	1:	Make	a	PDF	Editable	on
Mac	with	Offline	PDF	Editor	You	may	dislike	PDF	editing	because	of	the	impression	that	it	is	either	complicated	or	expensive,	forget	about	those	old	days.	We	have	more	PDF	editors	today	that	provide	time-efficient	and	professional	way	of	editing	PDF.	Cisdem	PDFMaster	is	highly	recommended,	it	offers	a	comprehensive	suite	of	editing	tools,
excellent	user	experience	and	useful	features.	The	reason	why	Cisdem	PDFMaster	stands	out	from	so	many	PDF	editors	lies	in	its	broad	range	of	features	and	affordable	price,	it	even	offer	a	7	day	free	trial	for	new	users	to	test	its	premium	functions.	Main	features	of	Cisdem	PDFMaster	Edit	PDFs:	add/delete/edit	texts	or	images	Add	comment,	stamp,
signature,	watermark	to	PDF	Compare,	compress,	crop,	protect,	redact	PDFs	Create	PDF	forms	with	fillable	fields	Organize	pages	Convert	PDF	to	10+	formats	View,	bookmark	and	print	PDFs	To	make	a	PDF	editable	on	Mac,	Cisdem	has	three	options:	Edit	a	native	PDF	directly	Make	scanned	PDF	editable	with	OCR	tool	Convert	PDF	to	editable
formats	without	losing	formatting	Directly	Edit	Text	or	Images	in	PDF	without	Changing	Format	Download	and	install	PDFMaster	on	your	Mac.	Free	Download	macOS	11	or	later	Earlier	than	macOS	11,	click	here	Click	Open	Fileto	import	the	PDF	file.	Then	go	to	Edit	PDF,	select	the	texts	you	want	to	edit,	you	can	also	adjust	the	paragraph	formatting,
like	font,	size,	alignment,	text	style	or	add	link.	After	edit,	click	on	Save	to	save	the	editing.	Make	Scanned	PDF	Editable	on	Mac	Open	the	scanned	PDF	in	Cisdem	PDFMaster.	Click	OCR	in	the	tool	bar.	Choose	OCR	pages,	OCR	Plan(Cisdem	PDFMaster	comes	with	2	OCR	plan	-	Online	or	Offline,	while	the	online	plan	support	more	OCR	languages	than
the	offline	plan	)	Click	OCR	to	digitize	text	from	scanned	PDF	or	image	files.	Now	the	scanned	PDF	becomes	editable,	click	on	save	as	txt	or	save	as	PDF	to	store	the	editable	file.	Make	PDF	in	Editable	Format	on	Mac	Free	download	and	launch	Cisdem	PDFMaster	on	your	Mac.	Open	PDF	in	Cisdem	PDFMaster,	clickConverter	in	the	tool	bar.	Choose
the	format	you	need,	here	we	choose	to	convert	to	editable	Word.	In	the	pop	up	windows,	set	the	layout	setting	and	the	page	or	page	range	you	need	to	convert	and	click	Convert	to	start	converting	PDF	files	to	editable	word.	(Optional)	To	batch	convert	PDF	toeditable	format,	you	can	go	back	to	the	main	interface	and	click	batch	in	the	main	interface.
Then	you	can	add	batches	of	PDF	files,	set	the	page	or	page	ranges	you	need	to	convert,	and	start	to	convert	PDF	to	editable	formats	in	batches.	Method	2:	Make	PDF	Editable	on	Mac	with	Preview	Preview	is	the	default	app	that	open	a	PDF	file	on	Mac.Besides	viewing	PDF	files,	italso	comes	with	a	full	set	of	tools	that	can	help	one	easily	edit	PDF	or
image	files,	though	it	dont	support	edit	existing	text	or	images	in	a	PDF	file.	You	can	utilize	Preview	to	view,	add	annotation,	markups,	print,	rotate,	resize,	rename,	highlight,	bookmark,	share,	export	and	edit	PDFs.	With	the	Markup	toolbar,	you	can	add	sketch,	shape,	text,	signature,	note	to	a	PDF.	If,	However,	you	want	to	edit	the	existing	PDF	text,
you	can	also	use	the	white	out	function	to	white	out	and	hide	the	text	then	use	text	tools	to	add	new	texts	to	the	white	out	place.	In	addition,	Preview	don't	support	convert	PDF	files	to	other	formats	to	make	it	editable.	Make	PDF	Editable	on	Mac	Free	with	Preview---	Add	New	Texts	Open	PDF	with	Preview	App.	Click	on	following	Markup	toolbar.
Click	on	T	icon	to	add	a	new	text	filed	to	a	blank	area	of	your	PDF.	Click	on	A	icon	to	change	font	style	or	size,	input	your	texts.	Make	PDF	Editable	on	Mac	Free	with	Preview	---Replace	Texts	Open	PDF	with	Preview	App.	Click	on	Markup	tool,	then	choose	White	color	for	both	border	color	and	fill	color.	Draw	a	white	rectangle	shape	to	white	out	the
texts	you	want	to	replace	with	new	texts.	Then	click	on	T	to	add	a	new	text	filed	to	the	white	out	area	and	click	A	to	change	font	settings.	Now	your	PDF	becomes	editable	on	Mac,	you	can	edit	the	text	or	add	other	contents.	Method	3:	Make	PDF	Editable	on	Mac	with	LibreOffice	LibreOffice	is	totally	free	to	use	and	it	allow	Mac	users	to	open	and	view
PDF	files,	when	you	add	PDF	files	to	the	program,	LibreOffice	will	instantly	make	the	PDF	editable,	you	can	easily	update	text	or	images.	LibreOffice	does	a	great	job	handing	simple	PDF	files,	you	just	need	to	click	open	file	to	navigate	and	add	the	PDF	file.	Note	that	if	your	PDF	is	large	it	will	take	some	time	to	loadingthe	file.	After	loading	the	PDF
file,	just	choose	the	text	you	need	to	edit	and	double	click	on	it	to	change	the	text.	In	the	right	side	of	the	interface,	you	can	change	properties	like	text	style	of	text	color,	and	you	can	add	annotations	like	highlight,	underline,	cross-out,	etc.	LibreOffice	is	free	and	lightweight,	it	is	few	options	that	enable	user	to	edit	text	directly	in	PDF	file,	and	its	free.
Though	for	some	complex	PDF	files	when	opening	with	LibreOffice	it	will	find	that	the	format	and	layout	are	messed	up.	If	you	found	LibreOffice	only	load	the	first	page	of	your	PDF	file	you	can	use	the	page	pane	to	navigate	between	pages.	Click	View	>	Page	pane.	Method	4:	Make	PDF	Editable	on	Mac	with	Google	Drive	If	you	dont	work	on	PDF	very
often,	neither	you	are	working	on	highly	private	PDF	files,	you	can	try	to	make	PDF	editable	online	for	free.	Assuming	you	have	a	Google	Account,	you	can	make	PDF	editable	with	Google	Drive,	the	platform	Google	helps	to	manage	files	online.	Compared	with	other	online	PDF	editors,	it	have	no	limit	on	file	size	and	numbers.	Also,it	is	safe	to	use.	Log
into	your	Google	Account	>	Google	Drive.	Click	"New"	>File	Upload,	import	the	PDF	file	that	you	want	to	make	in	editable	format.	Once	uploaded,	right	click	to	"Open	with	Google	Docs",	if	your	PDFs	are	scanned	copies,	an	OCR	processing	will	start	automatically.	Your	PDF	will	be	opened	in	Google	Docs	and	it	becomes	editable.	After	the	editing,
choose	"File"	>	"Download	as"	to	choose	the	editable	output	format	you	want	to	save	your	PDF	as.	Notes:	The	file	quality	(image	resolution,	format,	layout,	etc)	may	lost	a	little,	remember	to	check	and	manually	adjust	for	accurate	editable	file.	Method	5:	Make	PDF	Editable	withAdobe	Acrobat	If	you	have	installed	Adobe,	I	mean	the	Adobe	Acrobat,
not	Adobe	Reader,	you	can	make	PDF	editable	on	Mac	within	this	program.	It	can	edit	PDF	texts	easily	and	efficiently.	No	matter	your	PDF	is	native	or	scanned,	once	you	import	it	to	Adobe,	it	becomes	editable	and	every	single	word	in	your	PDF	can	be	edited,	modified,	added	or	deleted,	though	these	powerful	features	come	with	a	high	price	tag.
Here	we	take	Adobe	Acrobat	DC	to	demonstrate	how	to	make	PDF	editable	on	Mac.	Open	PDF	with	Adobe	Acrobat	DC.	Go	to	Tools	>	Edit	PDF,	now	you	can	edit	PDF	files	on	Mac.	(Optional)	For	scanned	PDFs,	you	can	go	to	Tools	>	Enhance	Scans	>	Recognize	Text	>	in	This	File	to	make	a	image	PDF	editable	on	Mac.	After	editing,	save	the	file.
Done!	Of	course,	you	can	go	to	"File"and	export	PDF	as	other	editable	format	if	you	want	to.	Basic	Knowledge	of	Edit	PDF	on	Mac	PDF	files	aredifferent	from	document	files	output	by	document	creation/editing	software	like	Word,	Excel,	PPT,	Pages,	Keynote,	etc.	You	are	usually	unable	to	edit	PDF	files.	As	PDF	files	are	made	to	ensure	given	the	same
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The	defenders,	with	their	personal	belongings,	are	allowed	to	retire	to	Tyre.	Captured	prisoners	are	exchanged	for	those	held	by	Richard	Filangieri,	commander	of	the	Lombards,	at	Tyre.	Cyprus	is	wholly	restored	under	the	rule	of	the	16-year-old	King	Henry	I	("the	Fat").	His	vassals	are	rewarded,	and	loans	that	they	have	made	are	repaid.[1]August
20	Oath	of	Bereg:	King	Andrew	II	of	Hungary	vows	to	the	Holy	See	that	he	will	not	employ	Jews	and	Muslims	to	administer	royal	revenues,	which	causes	diplomatic	complaints	and	ecclesiastical	censures.[2]Winter	Reconquista:	King	Ferdinand	III	of	Castile	("the	Saint")	conquers	the	cities	of	Trujillo	and	beda.	The	Castilian	army	besieges	the	city	of
Peniscola.	Ferdinand	forces	Ibn	Hud,	ruler	of	the	Taifa	of	Zaragoza,	to	sign	a	truce.[3]August	Richard	Marshal,	3rd	Earl	of	Pembroke,	signs	an	alliance	with	Llywelyn	the	Great,	to	join	forces	to	revolt	against	King	Henry	III.	Richard	is	faced	by	demands	from	royal	bailiffs	in	September	where	the	garrison	of	Usk	Castle	is	forced	to	surrender.November
Henry	III's	army	camped	at	Grosmont	Castle	is	attacked	in	the	night,	by	a	force	of	Welsh	and	English	rebels.	Several	of	Henry's	supporters	are	captured,	and	the	castle	is	returned	to	Hubert	de	Burgh,	one	of	the	rebels.May	29	MongolJin	War:	The	Mongol	army	led	by	gedei	Khan	captures	Kaifeng,	capital	of	the	Jin	dynasty	('Great	Jin'),	after	the	13-
month	Siege	of	Kaifeng	(1232).	The	Mongols	plunder	the	city,	while	Emperor	Aizong	of	Jin	flees	for	the	town	of	Caizhou.	Meanwhile,	gedei	departs	and	leaves	the	final	conquest	to	his	favoured	general,	Subutai.December	Siege	of	Caizhou:	The	Mongols	under	gedei	Khan	besiege	Caizhou	and	ally	themselves	with	the	Chinese	Song	dynasty	to	eliminate
the	Jin	Dynasty.Gendt	receives	its	city	rights	from	Otto	II	("the	Lame"),	count	of	Guelders	(modern	Netherlands).Pope	Gregory	IX	establishes	the	Papal	Inquisition,	to	regularize	the	persecution	of	heresy.June/July	Ibn	Manzur,	Arab	lexicographer	and	writer	(d.	1312)August	15	Philip	Benizi	de	Damiani,	Italian	religious	leader	(d.	1285)October	Al-
Nawawi,	Syrian	scholar,	jurist	and	writer	(d.	1277)Adelaide	of	Burgundy,	duchess	of	Brabant	(d.	1273)Choe	Ui,	Korean	military	leader	and	dictator	(d.	1258)Ibn	al-Quff,	Ayyubid	physician	and	surgeon	(d.	1286)Sancho	of	Castile,	archbishop	of	Toledo	(d.	1261)January	6	Matilda	of	Chester,	Countess	of	Huntingdon	(or	Maud),	English	noblewoman	(b.
1171)January	18	Yang	(or	Gongsheng),	Chinese	empress	(b.	1162)February	12	Ermengarde	de	Beaumont,	queen	of	ScotlandMarch	1	Thomas	I	(or	Tommaso),	count	of	Savoy	(b.	1178)May	Simon	of	Joinville,	French	nobleman	and	knight	(b.	1175)June	Yolanda	de	Courtenay,	queen	consort	of	HungaryJuly	8	Konoe	Motomichi,	Japanese	nobleman	(b.
1160)July	26	Wilbrand	of	Oldenburg,	prince-bishop	of	UtrechtJuly	27	Ferdinand	(or	Ferrand),	count	of	Flanders	(b.	1188)July	29	Savari	de	Maulon,	French	nobleman	(b.	1181)July	30	Konrad	von	Marburg,	German	priest	(b.	1180)October	8	Ugo	Canefri,	Italian	health	worker	(b.	1148)October	22	Fujiwara	no	Shunshi,	Japanese	empress	consort	(b.
1209)November	22	Helena,	duchess	of	Brunswick-LneburgNovember	27	Shi	Miyuan,	Chinese	politician	(b.	1164)Ibn	al-Athir,	Seljuk	historian	and	biographer	(b.	1160)Bertran	de	Born	lo	Filhs,	French	troubadour	(b.	1179)Bohemond	IV	("the	One-Eyed"),	prince	of	Antioch	(b.	1175)Gkbri	("Blue-Wolf"),	Ayyubid	general	and	ruler	(b.	1154)Guilln	Prez	de
Guzmn,	Spanish	nobleman	(b.	1180)John	Apokaukos,	Byzantine	bishop	and	theologianMathilde	of	Angoulme,	French	noblewoman	(b.	1181)Sayf	al-Din	al-Amidi,	Ayyubid	scholar	and	jurist	(b.	1156)William	Comyn,	Scoto-Norman	nobleman	(b.	1163)^	Steven	Runciman	(1952).	A	History	of	The	Crusades.	Vol	III:	The	Kingdom	of	Acre,	pp.	169170.
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ISBN90-04-12951-0.[permanent	dead	link]Retrieved	from	"	3One	hundred	years,	from	1101	to	1200See	also:	Renaissance	of	the	12th	centuryMillennia2ndmillenniumCenturies11thcentury12thcentury13thcenturyTimelines11thcentury12thcentury13thcenturyState
leaders11thcentury12thcentury13thcenturyDecades1100s1110s1120s1130s1140s1150s1160s1170s1180s1190sCategories:Births	Deaths	Establishments	DisestablishmentsvteEastern	Hemisphere	at	the	beginning	of	the	12th	centuryThe	12th	century	is	the	period	from	1101	to	1200	in	accordance	with	the	Julian	calendar.	In	the	history	of	European
culture,	this	period	is	considered	part	of	the	High	Middle	Ages	and	overlaps	with	what	is	often	called	the	"'Golden	Age'	of	the	Cistercians".	The	Golden	Age	of	Islam	experienced	significant	development,	particularly	in	Islamic	Spain.In	Song	dynasty	China,	an	invasion	by	Jurchens	caused	a	political	schism	of	north	and	south.	The	Khmer	Empire	of
Cambodia	flourished	during	this	century,	while	the	Fatimids	of	Egypt	were	overtaken	by	the	Ayyubid	dynasty.	Following	the	expansions	of	the	Ghaznavids	and	Ghurid	Empire,	the	Muslim	conquests	in	the	Indian	subcontinent	took	place	at	the	end	of	the	century.The	Ghurid	Empire	converted	to	Islam	from	Buddhism.1101:	In	July,	the	Treaty	of	Alton	is
signed	between	Henry	I	of	England	and	his	older	brother	Robert,	Duke	of	Normandy	in	which	Robert	agrees	to	recognize	Henry	as	king	of	England	in	exchange	for	a	yearly	stipend	and	other	concessions.	The	agreement	temporarily	ends	a	crisis	in	the	succession	of	the	Anglo-Norman	kings.11011103:	David	the	Builder	takes	over	Kakheti	and	Hereti
(now	parts	of	Georgia).1102:	King	Coloman	unites	Hungary	and	Croatia	under	the	Hungarian	Crown.1102:	Muslims	conquer	Seoro	de	Valencia.11031104:	A	church	council	is	convened	by	King	David	the	Builder	in	Urbnisi	to	reorganize	the	Georgian	Orthodox	Church.1104:	In	the	Battle	of	Ertsukhi,	King	David	the	Builder	defeats	an	army	of
Seljuks.1104:	King	Jayawarsa	of	Kadiri	(on	Java)	ascends	to	the	throne.[citation	needed]1106:	Battle	of	Tinchebray.11071111:	Sigurd	I	of	Norway	becomes	the	first	Norwegian	king	to	embark	on	a	crusade	to	the	Holy	Land.	He	fights	in	Lisbon	and	on	various	Mediterranean	isles	and	helps	the	King	of	Jerusalem	to	take	Sidon	from	the	Muslims.1108:	By
the	Treaty	of	Devol,	signed	in	September,	Bohemond	I	of	Antioch	has	to	submit	to	the	Byzantine	Empire,	becoming	the	vassal	of	Alexius	I.1109:	On	June	10,	Bertrand	of	Toulouse	captures	the	County	of	Tripoli	(northern	Lebanon/western	Syria).1109:	In	the	Battle	of	Nako,	Boleslaus	III	Wrymouth	defeats	the	Pomeranians	and	re-establishes	Polish
access	to	the	sea.1109:	On	August	24,	in	the	Battle	of	Hundsfeld,	Boleslaus	III	Wrymouth	defeats	Emperor	Henry	V	of	Germany	and	stops	German	expansion	eastward.1111:	On	April	14,	during	Henry	V's	first	expedition	to	Rome,	he	is	crowned	Holy	Roman	Emperor.1113:	Paramavishnulok	is	crowned	as	King	Suryavarman	II	in	Cambodia.	He	expands
the	Khmer	Empire	and	builds	Angkor	Wat	during	the	first	half	of	the	century.	He	establishes	diplomatic	relations	with	China.1115:	The	Georgian	army	occupies	Rustavi	in	the	war	with	the	Muslims.1115:	In	Java,	King	Kamesvara	of	Kadiri	ascends	to	the	throne.	Janggala	ceases	to	exist	and	comes	under	Kadiri	domination,	highly	possible	under	royal
marriage.	During	his	reign,	Mpu	Dharmaja	writes	Kakawin	Smaradahana,	a	eulogy	for	the	king	which	become	the	inspiration	for	the	Panji	cycle	tales,	which	spread	across	Southeast	Asia.[1]1116:	The	Byzantine	army	defeats	the	Turks	at	Philomelion.1116:	Death	of	doa	Jimena	Daz,	governor	of	Valencia	from	1099	to	1102.c.	1119:	The	Knights	Templar
are	founded	to	protect	Christian	pilgrims	in	Jerusalem.A	Black	and	White	Photo	of	the	12th	century	Cuenca	Cathedral	(built	from	1182	to	1270)	in	Cuenca,	Spain1120:	On	January	16,	the	Council	of	Nablus,	a	council	of	ecclesiastic	and	secular	lords	in	the	crusader	Kingdom	of	Jerusalem,	establishes	the	first	written	laws	for	the	kingdom.1120:	On
November	25,	William	Adelin,	the	only	legitimate	son	of	King	Henry	I	of	England,	drowns	in	the	White	Ship	Disaster,	leading	to	a	succession	crisis	which	will	bring	down	the	Norman	monarchy	of	England.1121:	On	August	12,	in	the	Battle	of	Didgori,	the	greatest	military	victory	in	Georgian	history,	King	David	the	Builder	with	45,000	Georgians,
15,000	Kipchak	auxiliaries,	500	Alan	mercenaries	and	100	French	Crusaders	defeats	a	much	larger	Seljuk-led	Muslim	coalition	army.1121:	On	December	25,	St.	Norbert	and	29	companions	make	their	solemn	vows	in	Premontre,	France,	establishing	the	Premonstratensian	Order.1122:	The	Battle	of	Beroia	(Modern-day	Stara	Zagora,	Bulgaria)	results
in	the	disappearance	of	the	Pechenegs	Turkish	tribe	as	an	independent	force.1122:	On	September	23,	the	Concordat	of	Worms	(Pactum	Calixtinum)	is	drawn	up	between	Emperor	Henry	V	and	Pope	Calixtus	II	bringing	an	end	to	the	first	phase	of	the	power	struggle	between	the	papacy	and	the	Holy	Roman	Empire.1122:	King	David	the	Builder
captures	Tbilisi	and	declares	it	the	capital	city	of	Georgia,	ending	400	years	of	Arab	rule.1123:	The	Jurchen	dynasty	of	China	forces	Koryo	(now	Korea)	to	recognize	their	suzerainty.1124:	In	April	or	May,	David	I	is	crowned	King	of	the	Scots.1125:	On	June	11,	in	the	Battle	of	Azaz,	the	Crusader	states,	led	by	King	Baldwin	II	of	Jerusalem,	defeat	the
Seljuk	Turks.1125:	In	November,	the	Jurchens	of	the	Jin	dynasty	declare	war	on	the	Song	dynasty,	beginning	the	JinSong	wars.1125:	Lothair	of	Supplinburg,	duke	of	Saxony,	is	elected	Holy	Roman	Emperor	instead	of	the	nearest	heir,	Frederick	of	Swabia,	beginning	the	great	struggle	between	Guelphs	and	Ghibellines.1127:	The	Northern	Song	dynasty
loses	power	over	northern	China	to	the	Jin	dynasty.1128:	On	June	24,	the	Kingdom	of	Portugal	gains	independence	from	the	Kingdom	of	Len	at	the	Battle	of	So	Mamede;	(recognised	by	Len	in	1143).The	temple	complex	of	Angkor	Wat,	built	during	the	reign	of	Suryavarman	II	in	Cambodia	of	the	Khmer	Era.11301180:	50-year	drought	in	what	is	now
the	American	Southwest.11301138:	Papal	schism,	Pope	Innocent	II	vs.	Antipope	Anacletus	II.1130:	On	March	26,	Sigurd	I	of	Norway	dies.	A	golden	era	of	95	years	comes	to	an	end	for	Norway	as	civil	wars	between	the	members	of	Harald	Fairhair's	family	line	rage	for	the	remainder	of	the	century.1130:	On	Christmas	Day,	Roger	II	is	crowned	King	of
Sicily,	the	royal	title	being	bestowed	on	him	by	Antipope	Anacletus	II.1132:	The	Southern	Song	dynasty	establishes	China's	first	permanent	standing	navy,	although	China	had	a	long	naval	history	prior.	The	main	admiral's	office	is	at	the	port	of	Dinghai.11321183:	the	Chinese	navy	increases	from	a	mere	3,000	to	52,000	marine	soldiers	stationed	in	20
different	squadrons.	During	this	time,	hundreds	of	treadmill-operated	paddle	wheel	craft	are	assembled	for	the	navy	to	fight	the	Jin	dynasty	in	the	north.1135:	King	Jayabaya	of	Kadiri	ascends	to	the	throne.[2]11351154:	The	Anarchy	takes	place,	during	a	period	of	civil	war	in	England.1136:	Suger	begins	rebuilding	the	abbey	church	at	St	Denis	north
of	Paris,	which	is	regarded	as	the	first	major	Gothic	building.1137:	On	July	22,	the	future	King	Louis	VII	of	France	marries	Eleanor,	the	Duchess	of	Aquitaine.1138:	On	October	11,	the	1138	Aleppo	earthquake	devastates	much	of	northern	Syria.1139:	in	April,	the	Second	Lateran	Council	ends	the	papal	schism.1139:	On	July	5,	in	the	Treaty	of	Mignano,
Pope	Innocent	II	confirms	Roger	II	as	King	of	Sicily,	Duke	of	Apulia,	and	Prince	of	Capua	and	invests	him	with	his	titles.1139:	On	July	25,	the	Portuguese	defeat	the	Almoravids	led	by	Ali	ibn	Yusuf	in	the	Battle	of	Ourique;	Prince	Afonso	Henriques	is	acclaimed	King	of	Portugal	by	his	soldiers.Averroes	in	a	14th-century	painting	by	Andrea	di
Bonaiuto11401150:	Collapse	of	the	Ancestral	Puebloan	culture	at	Chaco	Canyon	(modern-day	New	Mexico).1141:	The	Treaty	of	Shaoxing	ends	the	conflict	between	the	Jin	dynasty	and	Southern	Song	dynasty,	legally	establishing	the	boundaries	of	the	two	countries	and	forcing	the	Song	dynasty	to	renounce	all	claims	to	its	former	territories	north	of
the	Huai	River.	The	treaty	reduces	the	Southern	Song	into	a	quasi-tributary	state	of	the	Jurchen	Jin	dynasty.1143:	Manuel	I	Komnenos	is	crowned	as	Byzantine	emperor	after	the	death	of	John	II	Komnenos.1143:	Afonso	Henriques	is	proclaimed	King	of	Portugal	by	the	cortes.1143:	The	Treaty	of	Zamora	recognizes	Portuguese	independence	from	the
Kingdom	of	Len.	Portugal	also	recognizes	the	suzerainty	of	the	pope.1144:	On	December	24,	Edessa	falls	to	the	Atabeg	Zengi.11451148:	The	Second	Crusade	is	launched	in	response	to	the	fall	of	the	County	of	Edessa.1147:	On	October	25,	the	four-month-long	Siege	of	Lisbon	successfully	brings	the	city	under	definitive	Portuguese	control,	expelling
the	Moorish	overlords.1147:	A	new	Berber	dynasty,	the	Almohads,	led	by	Emir	Abd	al-Mu'min,	takes	North	Africa	from	the	Almoravides	and	soon	invades	the	Iberian	Peninsula.	The	Almohads	began	as	a	religious	movement	to	rid	Islam	of	impurities.1147:	The	Wendish	Crusade	against	the	Polabian	Slavs	(or	"Wends")	in	what	is	now	northern	and
eastern	Germany.1150:	Ramon	Berenguer	IV,	Count	of	Barcelona	marries	Petronilla,	the	Queen	of	Aragon.1151:	The	Treaty	of	Tudiln	is	signed	by	Alfonso	VII	of	Len	and	Raymond	Berengar	IV,	Count	of	Barcelona,	recognizing	the	Aragonese	conquests	south	of	the	Jcar	and	the	right	to	expand	in	and	annex	the	Kingdom	of	Murcia.1153:	The	Treaty	of
Wallingford,	ends	the	civil	war	between	Empress	Matilda	and	her	cousin	King	Stephen	of	England	fought	over	the	English	crown.	Stephen	acknowledges	Matilda's	son	Henry	of	Anjou	as	heir.1153:	The	First	Treaty	of	Constance	is	signed	between	Emperor	Frederick	I	and	Pope	Eugene	III,	by	the	terms	of	which,	the	emperor	is	to	prevent	any	action	by
Manuel	I	Comnenus	to	reestablish	the	Byzantine	Empire	on	Italian	soil	and	to	assist	the	pope	against	his	enemies	in	revolt	in	Rome.1154:	the	Moroccan-born	Muslim	geographer	Muhammad	al-Idrisi	publishes	his	Geography.1154:	On	December	27,	Henry	II	is	crowned	King	of	England	at	Westminster	Abbey.1155:	Pope	Adrian	IV	grants	overlordship	of
Ireland	to	Henry	II	of	England	in	the	bull	Laudabiliter.1156:	On	June	18,	the	Treaty	of	Benevento	is	entered	into	by	Pope	Adrian	IV	and	the	Norman	Kingdom	of	Sicily.	After	years	of	turbulent	relations,	the	popes	finally	settles	down	to	peace	with	the	Hauteville	kings.	The	kingship	of	William	I	is	recognized	over	all	Sicily,	Apulia,	Calabria,	Campania,
and	Capua.	The	tribute	to	the	pope	of	600	schifati	agreed	upon	by	Roger	II	in	1139	at	Mignano	is	affirmed	and	another	400	shift	is	added	for	the	new	lands.1158:	The	Treaty	of	Sahagn	ends	the	war	between	Castile	and	Len.The	Liuhe	Pagoda	of	Hangzhou,	China,	11651161:	the	Song	dynasty	Chinese	navy,	employing	gunpowder	bombs	launched	from
trebuchets,	defeats	the	enormous	Jin	dynasty	navy	in	the	East	China	Sea	in	the	Battle	of	Tangdao	and	on	the	Yangtze	River	in	the	Battle	of	Caishi.1161:	Kilij	Arslan	II,	Sultan	of	Rum,	makes	peace	with	the	Byzantine	Empire,	recognizing	the	emperor's	primacy.1161:	In	the	siege	of	Ani,	troops	from	the	Kingdom	of	Georgia	take	control	over	the	city,	only
to	have	it	sold	for	the	second	time	to	the	Shaddadids,	a	Kurdish	dynasty.1162:	Genghis	Khan,	the	founder	of	the	Mongol	Empire,	is	born	as	Temjin	in	present-day	Mongolia.1163:	The	Norwegian	Law	of	Succession	takes	effect.11651182:	Tensions	and	disputes	between	the	Pagan	Empire	and	the	Kingdom	of	Polonnaruwa	causes	the	Sinhalese	under
Parakramabahu	the	Great	to	raid	Burma.1168:	King	Valdemar	I	of	Denmark	conquers	Arkona	on	the	Island	of	Rgen,	the	strongest	pagan	fortress	and	temple	in	northern	Europe.1169:	Political	disputes	within	the	Pandya	Empire	sparks	the	decade-long	Pandyan	Civil	War.1169:	On	May	1,	the	Norman	invasion	of	Ireland	begins.	Richard	fitzGilbert	de
Clare	('Strongbow')	allies	with	the	exiled	Irish	chief,	Dermot	MacMurrough,	to	help	him	recover	his	kingdom	of	Leinster.The	defense	of	the	Carroccio	during	the	battle	of	Legnano	(1176)	by	Amos	Cassioli	(18321891)1170:	The	Treaty	of	Sahagn	is	signed	by	Alfonso	VIII	of	Castile	and	Alfonso	II	of	Aragon.	Based	on	the	terms	of	the	accord,	Alfonso	VIII
agrees	to	provide	Alfonso	II	with	three	hostages,	to	be	used	as	tribute	payments	owed	by	Ibn	Mardan	of	Valencia	and	Murcia.1170:	On	December	29,	Thomas	Becket	is	murdered	in	Canterbury	Cathedral.1171:	Saladin	deposes	the	last	Fatimid	Caliph	Al-'id	and	establishes	the	Ayyubid	dynasty.1171:	On	November	11,	Henry	II	of	England	lands	in
Ireland	to	assert	his	claim	as	Lord	of	Ireland.1172:	The	Pandyan	city	of	Madurai	is	sacked	by	the	Sinhalese	army	due	to	an	attempt	to	drive	off	the	rival	throne	claimant,	Kulasekara	Pandyan.1173:	Sinhalese	king	Parakramabahu	the	Great	gains	a	decisive	victory	by	invading	the	Chola	Empire	as	an	ally	of	the	Pandyas	in	the	Pandyan	Civil	War.1174:	On
July	12,	William	I	of	Scotland	is	captured	by	the	English	in	the	Battle	of	Alnwick.	He	accepts	the	feudal	overlordship	of	the	English	crown	and	pays	ceremonial	allegiance	at	York.1175:	Hnen	Shnin	(Genk)	founds	the	Jdo	sh	(Pure	Land)	sect	of	Buddhism.1175:	The	Treaty	of	Windsor	is	signed	by	King	Henry	II	of	England	and	the	High	King	of	Ireland,
Ruaidr	Ua	Conchobair.1176:	On	May	29,	Frederick	Barbarossa's	forces	are	defeated	in	the	Battle	of	Legnano	by	the	Lombard	League	which	results	in	the	emperor's	acknowledgment	of	the	pope's	sovereignty	over	the	Papal	States	and	Alexander	acknowledging	the	emperor's	overlordship	of	the	imperial	Church.1176:	On	September	17,	The	Battle	of
Myriokephalon	(Myriocephalum;	Turkish:	Miryakefalon	Sava)	is	fought	between	the	Byzantine	Empire	and	the	Seljuk	Turks	in	Phrygia.	It	is	a	serious	reversal	for	the	Byzantine	forces	and	will	be	the	final,	unsuccessful,	effort	by	the	Byzantines	to	recover	the	interior	of	Anatolia	from	the	Seljuk	Turks.1177:	The	Treaty	or	Peace	of	Venice	is	signed	by	the
papacy	and	its	allies,	and	Frederick	I,	Holy	Roman	Emperor.	The	Norman	Kingdom	of	Sicily	also	participates	in	negotiations	and	the	treaty	thereby	determines	the	political	course	of	all	of	Italy	for	the	next	several	years.1178:	Chinese	writer	Zhou	Qufei,	a	Guangzhou	customs	officer,	writes	of	an	island	far	west	in	the	Indian	Ocean	(possibly
Madagascar),	from	where	people	with	skin	"as	black	as	lacquer"	and	with	frizzy	hair	were	captured	and	purchased	as	slaves	by	Arab	merchants.1179:	The	Treaty	of	Cazola	(Cazorla)	is	signed	by	Alfonso	II	of	Aragon	and	Alfonso	VIII	of	Castile,	dividing	Andalusia	into	separate	zones	of	conquest	for	the	two	kingdoms,	so	that	the	work	of	the	Reconquista
would	not	be	stymied	by	internecine	feuding.1180:	The	Portuguese	Navy	defeats	a	Muslim	fleet	off	the	coast	of	Cape	Espichel.11801185:	the	Genpei	War	in	Japan.1181:	Parakramabahu	the	Great	conducts	a	large-scale	raid	on	Burma,	after	a	ship	transporting	a	Sinhalese	princess	to	the	Khmer	Empire	is	attacked	by	Burmese	naval	fleets.1182:
Religious	reformations	of	Theravada	Buddhism	in	Pagan	Burma	under	the	patronage	of	Narapatisithu	are	continued	with	the	end	of	the	Polonnaruwa-Pagan	War.1182:	Revolt	of	the	people	of	Constantinople	against	the	Latins,	whom	they	massacre,	proclaiming	Andronicus	I	Comnenus	as	co-emperor.1183:	On	January	25,	the	final	Peace	of	Constance
between	Frederick	Barbarossa,	the	pope	and	the	Lombard	towns	is	signed,	confirming	the	Peace	of	Venice	of	1177.1183:	On	September	24,	Andronicus	I	Comnenus	has	his	nephew	Alexius	II	Comnenus	strangled.1184:	On	March	24,	Queen	Tamar,	King	of	Georgia,	accedes	to	the	throne	as	sole	ruler	after	reigning	with	her	father,	George	III,	for	six
years.1184:	Diet	of	Pentecost	organised	by	Emperor	Frederick	I	in	Mainz.1185:	The	Uprising	of	Asen	and	Peter	against	the	Byzantine	Empire	leads	to	the	restoration	of	the	Bulgarian	Empire.1185:	Andronicus	I	Comnenus	is	deposed	and,	on	September	12,	executed	as	a	result	of	the	Norman	massacre	of	the	Greeks	of	Thessalonika.1185:	The	cathedral
school	(Katedralskolan)	in	Lund,	Sweden,	is	founded.	The	school	is	the	oldest	in	northern	Europe	and	one	of	the	oldest	in	all	of	Europe.1185:	Beginning	in	this	year	the	Kamakura	shogunate	deprives	the	emperor	of	Japan	of	political	power.1186:	On	January	27,	the	future	Holy	Roman	Emperor	Henry	VI	marries	Constance	of	Sicily,	the	heiress	to	the
Sicilian	throne.1187:	On	July	4,	in	the	Battle	of	Hattin,	Saladin	defeats	the	king	of	Jerusalem.1187:	In	August,	the	Swedish	royal	and	commercial	center	Sigtuna	is	attacked	by	raiders	from	Karelia,	Couronia,	and/or	Estonia.[3]1188:	The	Riah	were	introduced	into	the	Habt	and	south	of	Tetouan	by	the	Almohad	caliph,	Abu	Yusuf	Yaqub	al-Mansur,	and
Jochem	and	Acem	were	introduced	in	Tamesna.[4]1189:	On	September	3,	Richard	I	is	crowned	King	of	England	at	Westminster.1189:	On	November	11,	William	II	of	Sicily	dies	and	is	succeeded	by	his	illegitimate	cousin	Tancred,	Count	of	Lecce	instead	of	Constance.11891192:	The	Third	Crusade	is	an	attempt	by	European	leaders	to	wrest	the	Holy
Land	from	Saladin.Richard	I	of	England,	or	Richard	the	Lionheart.1190:	On	June	10,	Emperor	Frederick	Barbarossa	drowns	in	the	River	Salef,	leaving	the	Crusader	army	under	the	command	of	the	rivals	Philip	II	of	France	and	Richard	I	of	England,	which	ultimately	leads	to	the	dissolution	of	the	army.1191:	Holy	Roman	Emperor	Henry	VI	attacked	the
Kingdom	of	Sicily	from	May	to	August	but	fails	and	withdrawn,	with	Empress	Constance	captured	(released	1192).1191:	On	September	7,	Saladin	is	defeated	by	Richard	I	of	England	at	the	Battle	of	Arsuf.1192:	In	April,	Isabella	I	begins	her	reign	as	Christian	Queen	of	the	Kingdom	of	Jerusalem1192:	In	the	Battle	of	Jaffa,	King	Richard	the	Lionheart
defeats	Saladin.1192:	In	June,	the	Treaty	of	Ramla	is	signed	by	Saladin	and	Richard	Lionheart.	Under	the	terms	of	the	agreement,	Jerusalem	will	remain	under	Muslim	control.	However,	the	city	will	be	open	to	Christian	pilgrims.	The	Latin	Kingdom	is	reduced	to	a	coastal	strip	that	extends	from	Tyre	to	Jaffa.1192:	Minamoto	no	Yoritomo	is	appointed
Sei-i	Taishgun,	"barbarian-subduing	great	general",	shgun	for	short,	the	first	military	dictator	to	bear	this	title.1192:	Sultan	Shahbuddin	Muhammad	Ghori	establishes	the	first	Muslim	empire	in	India	for	14	years	(11921206)	by	defeating	Prithviraj	Chauhan.1193:	Nalanda,	the	great	Indian	Buddhist	educational	centre,	is	destroyed.1194:	Emperor
Henry	VI	conquers	the	Kingdom	of	Sicily.1195:	On	June	16,	the	struggle	of	Shamqori.	Georgian	forces	annihilate	the	army	of	Abu	Baqar.1198:	The	brethren	of	the	Crusader	hospital	in	Acre	are	raised	to	a	military	order	of	knights,	the	Teutonic	Knights,	formally	known	as	the	Order	of	the	Knights	of	the	Hospital	of	St.	Mary	of	the	Teutons	in
Jerusalem.1199:	Pope	Innocent	III	writes	to	Kaloyan,	inviting	him	to	unite	the	Bulgarian	Church	with	the	Roman	Catholic	Church.1200:	Construction	begins	on	the	Grand	Village	of	the	Natchez	near	Natchez,	Mississippi.	This	ceremonial	center	for	the	Natchez	people	is	occupied	and	built	until	the	early	17th	century.[5]Eastern	Hemisphere	at	the	end
of	the	12th	centuryChina	is	under	the	Northern	Song	dynasty.	Early	in	the	century,	Zhang	Zeduan	paints	Along	the	River	During	the	Qingming	Festival.	It	will	later	end	up	in	the	Palace	Museum,	Beijing.In	southeast	Asia,	there	is	conflict	between	the	Khmer	Empire	and	the	Champa.	Angkor	Wat	is	built	under	the	Hindu	king	Suryavarman	II.	By	the	end
of	the	century,	the	Buddhist	Jayavarman	VII	becomes	the	ruler.Japan	is	in	its	Heian	period.	The	Chj-jinbutsu-giga	is	made	and	attributed	to	Toba	Sj.	It	ends	up	at	the	Kzan-ji,	Kyoto.In	Oceania,	the	Tui	Tonga	Empire	expands	to	a	much	greater	area.Europe	undergoes	the	Renaissance	of	the	12th	century.	The	blast	furnace	for	the	smelting	of	cast	iron	is
imported	from	China,	appearing	around	Lapphyttan,	Sweden,	as	early	as	1150.Alexander	Neckam	is	the	first	European	to	document	the	mariner's	compass,	first	documented	by	Shen	Kuo	during	the	previous	century.Christian	humanism	becomes	a	self-conscious	philosophical	tendency	in	Europe.	Christianity	is	also	introduced	to	Estonia,	Finland,	and
Karelia.The	first	medieval	universities	are	founded.	Pierre	Abelard	teaches.Middle	English	begins	to	develop,	and	literacy	begins	to	spread	outside	the	Church	throughout	Europe.[6]	In	addition,	churchmen	are	increasingly	willing	to	take	on	secular	roles.	By	the	end	of	the	century,	at	least	a	third	of	England's	bishops	also	act	as	royal	judges	in	secular
matters.[7]The	Ars	antiqua	period	in	the	history	of	the	medieval	music	of	Western	Europe	begins.The	earliest	recorded	miracle	play	is	performed	in	Dunstable,	England.Gothic	architecture	and	trouvre	music	begin	in	France.During	the	middle	of	the	century,	the	Cappella	Palatina	is	built	in	Palermo,	Sicily,	and	the	Madrid	Skylitzes	manuscript
illustrates	the	Synopsis	of	Histories	by	John	Skylitzes.Fire	and	plague	insurance	first	become	available	in	Iceland,	and	the	first	documented	outbreaks	of	influenza	there	happens.The	medieval	state	of	Serbia	is	formed	by	Stefan	Nemanja	and	then	continued	by	the	Nemanji	dynasty.By	the	end	of	the	century,	both	the	Capetian	dynasty	and	the	House	of
Anjou	are	relying	primarily	on	mercenaries	in	their	militaries.	Paid	soldiers	are	available	year-round,	unlike	knights	who	expected	certain	periods	off	to	maintain	their	manor	lifestyles.[8]In	India,	Hoysala	architecture	reaches	its	peak.In	the	Middle	East,	the	icon	of	Theotokos	of	Vladimir	is	painted	probably	in	Constantinople.	Everything	but	the	faces
will	later	be	retouched,	and	the	icon	will	go	to	the	Tretyakov	Gallery	of	Moscow.The	Georgian	poet	Shota	Rustaveli	composes	his	epic	poem	The	Knight	in	the	Panther's	Skin.Shahab	al-Din	Suhrawardi	founds	his	"school	of	illumination".In	North	Africa,	the	kasbah	of	Marrakesh	is	built,	including	the	city	gate	Bab	Agnaou	and	the	Koutoubia	mosque.In
sub-Saharan	Africa,	Kente	cloth	is	first	woven.In	France,	the	first	piedfort	coins	were	minted.The	city	of	Tula	burns	down,	marking	the	end	of	the	Toltec	EmpireIn	West	Africa	the	Ife	Empire	is	established.See	also:	Timeline	of	historic	inventions	12th	century1104:	The	Venice	Arsenal	of	Venice,	Italy,	is	founded.	It	employed	some	16,000	people	for	the
mass	production	of	sailing	ships	in	large	assembly	lines,	hundreds	of	years	before	the	Industrial	Revolution.1106:	Finished	building	of	Gelati.1107:	The	Chinese	engineer	Wu	Deren	combines	the	mechanical	compass	vehicle	of	the	south-pointing	chariot	with	the	distance-measuring	odometer	device.1111:	The	Chinese	Donglin	Academy	is
founded.1165:	The	Liuhe	Pagoda	of	Hangzhou,	China,	is	built.1170:	The	Roman	Catholic	notion	of	Purgatory	is	defined.[9]1185:	First	record	of	windmills.Wikimedia	Commons	has	media	related	to	12th	century.^	Soekmono,	R,	Drs.,	Pengantar	Sejarah	Kebudayaan	Indonesia	2,	2nd	ed.	Penerbit	Kanisius,	Yogyakarta,	1973,	5th	reprint	edition	in	1988
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